OU Campus End User Reference Guide

Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>OU Campus End User Reference Guide</td>
<td>1</td>
</tr>
<tr>
<td>End-User Introduction</td>
<td>4</td>
</tr>
<tr>
<td>Log In</td>
<td>4</td>
</tr>
<tr>
<td>Log In Overview</td>
<td>4</td>
</tr>
<tr>
<td>Editing a Page with DirectEdit</td>
<td>4</td>
</tr>
<tr>
<td>Editable Regions</td>
<td>5</td>
</tr>
<tr>
<td>Logging Out</td>
<td>5</td>
</tr>
<tr>
<td>Failed Logins and User Lockouts</td>
<td>6</td>
</tr>
<tr>
<td>Checked Out/In</td>
<td>6</td>
</tr>
<tr>
<td>Checked Out/In Overview</td>
<td>6</td>
</tr>
<tr>
<td>Checking Out a Page</td>
<td>6</td>
</tr>
<tr>
<td>Status Indicators</td>
<td>7</td>
</tr>
<tr>
<td>Checking In a Page</td>
<td>7</td>
</tr>
<tr>
<td>Behaviors of Checked Out Pages</td>
<td>7</td>
</tr>
<tr>
<td>Best Practices</td>
<td>7</td>
</tr>
<tr>
<td>WYSIWYG Editor</td>
<td>8</td>
</tr>
<tr>
<td>WYSIWYG Editor Overview</td>
<td>8</td>
</tr>
<tr>
<td>Toolbars and Tools</td>
<td>9</td>
</tr>
<tr>
<td>Toolbar Functionality</td>
<td>9</td>
</tr>
<tr>
<td>Toolbar Row 1</td>
<td>9</td>
</tr>
<tr>
<td>Toolbar Row 1 Overview</td>
<td>9</td>
</tr>
<tr>
<td>WYSIWYG Spell Check</td>
<td>10</td>
</tr>
<tr>
<td>Insert/Edit Link</td>
<td>10</td>
</tr>
<tr>
<td>Links and Dependency Manager</td>
<td>11</td>
</tr>
<tr>
<td>Example of a Dependency Tag</td>
<td>11</td>
</tr>
<tr>
<td>Inserting an Internal Link ( Typical)</td>
<td>11</td>
</tr>
<tr>
<td>Linking to an External Page</td>
<td>13</td>
</tr>
<tr>
<td>Specifying a Link Target</td>
<td>13</td>
</tr>
</tbody>
</table>
End-User Introduction
OU CampusTM provides users an easy way to manage web pages. With the ability to login directly from the departments ETSU website, it is easy to navigate to the page to be edited. Once logged in, users can simply click on the area to edit, and they are placed in a user-friendly What-You-See-Is-What-You-Get (WYSIWYG) Editor.

Log In

Log In Overview
Users can log in to OU Campus through a published page with the use of an on-page link known as DirectEditTM. Every page of a web site includes a DirectEdit link to allow users to log in directly to edit a page.

Editing a Page with DirectEdit
1. Click the DirectEdit link on the published page. ETSU’s DirectEdit link on the 2014 template is the copyright symbol in the footer of each page.

2. Log into OU Campus with your ETSU username and password.

3. Select an editable region by clicking one of the green edit buttons


5. Save and publish the page.

Support Specialist: Sherry Martinez
(martines@etsu.edu) 98249
Editable Regions
The view when accessing a page directly depends on the type of page or content being accessed. The page may include many editable regions or just one editable region. For example, the following image shows two editable regions, each of which the content is edited separately from the other regions. One Edit button corresponds to the right column and the other to the main content of the page.

Selecting an editable region button provides access to edit that area using the WYSIWYG Editor, by default.

Logging Out
User can log out from the global navigation bar.

1. Hover over the user’s name.
2. Choose Logout from the menu
3. The original Login screen is shown.

Failed Logins and User Lockouts
If a user incorrectly enters their login credentials more than three consecutive times, then they will automatically be locked out of the OU Campus system. In the event of a user lockout, contact Academic Technology Support at 439-8611 or email cms@etsu.edu.

Checked Out/In

Checked Out/In Overview
File status indicators reflect the state of an OU Campus page and other files. When a user edits a page by clicking an edit button, the page is automatically checked out to that user. Likewise, when the user publishes a page it is automatically checked back in. A user might also manually checked out a page as this makes other page options available. The file status indicators help make clear why a page is not available for editing as well as who has checked out a page or scheduled an action. These icons are shown on many of the screens that display listings of content, as well as the File Navigation sidebar, which is global to a site, and can be shown in the My Current Pages gadget if so configured.

For example, on the Pages list view (Content > Pages), the page status indicators are found in the flag column and reflect whether a page is checked out. A lit light bulb indicates a page is checked out to the currently logged in user and a red lock indicated the page is checked out to another user. An unlit light bulb indicates the file is checked in and available to check out.

Checking Out a Page
A page may be checked out from the following locations by clicking the unlit light bulb icon:

- Pages list view
- File Navigation sidebar
- Gadgets sidebar > My Current Pages gadget (if enabled)
- Dashboard > My Current Pages dashboard gadget (if enabled)
- Preview and Edit views

Regardless of the method used to check out a page, the status is updated accordingly.
Status Indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="78x690" alt="Light Bulb" /></td>
<td>An unlit light bulb indicates that the page is checked in and can be checked out for editing by any user with the proper permissions.</td>
</tr>
<tr>
<td><img src="78x690" alt="Light Bulb" /></td>
<td>A lit light bulb indicates that the page is checked out to the current user (the individual currently logged into, working in, and viewing OU Campus).</td>
</tr>
<tr>
<td><img src="78x690" alt="Lock" /></td>
<td>A red lock indicates that the page is checked out to another user. It is possible to hover over the lock to see to whom the page is checked out.</td>
</tr>
<tr>
<td><img src="78x690" alt="Calendar" /></td>
<td>A green calendar icon is the status indicator for a publish scheduled by the current user. The calendar icon can be clicked on by an administrator or the individual who scheduled the page to be published in order to change the publish date and time, or to cancel the publish completely.</td>
</tr>
<tr>
<td><img src="78x690" alt="Calendar" /></td>
<td>A red calendar icon is the status indicator for a publish scheduled by another user. The calendar icon can be clicked on by an administrator or the individual who scheduled the page to be published in order to change the publish date and time, or to cancel the publish completely.</td>
</tr>
</tbody>
</table>

Checking In a Page

It is valuable to note that pages stay checked out to the user until the user:

- Publishes the page.
- Checks the page back into the system by clicking on the lit (yellow) light bulb.

Behaviors of Checked Out Pages

If a page is checked out by another user, the current user may still perform the following actions; even though the page is locked:

- Edit access settings
- Edit reminders
- Preview the page
- View the log

Best Practices

Make sure to check the page back in when finished editing the page so it can be made available to other
WYSIWYG Editor

WYSIWYG Editor Overview
The WYSIWYG (What You See Is What You Get) Editor allows for a familiar experience of editing a page similar to that of many web applications and traditional word processors.

When logging into the system to directly edit a page, there may be several editable regions available. Only areas that are available to be edited by that user are shown with an edit button. Clicking on the Edit button above a region allow for the area to be edited. This opens the WYSIWYG Editor by default and the assigned toolbar is available.

Keep in mind that part of the configuration of the template design may include an image in the background that helps present a more accurate rendering of how the content will appear on the page. It is intended for visualization purposes and to help understand how the content is organized on the page into editable regions. Once the content has been saved, an actual view of the configured page can be seen using the Preview mode.

When editing in the WYSIWYG, modifications should be saved by clicking the Save icon before navigating away from the page. If an attempt is made to navigate away from the page without first saving it, the user notification is shown as a reminder to save the page.
Toolbars and Tools

Many of the editing tasks for a page such as inserting images and links, applying formatting such as bold, and spell checking a page can be accomplished from within the WYSIWYG using the toolbar.

Icons represent the tools. Clicking on any icon performs an action, either directly to the page, or to the selected text and graphics. Some icons display more options in a drop-down menu, or in a dialog.

The availability of a function is based on the selected items, or the location of the cursor on the page. For example, if nothing is selected, functions such as Insert Link are dimmed, signifying that this function is not available at the moment. For the Insert Link function button to be available, the user must first select text or a graphic.

In many cases, right-clicking offers contextual functions. For example, right-clicking within a table provides a list of available table editing and formatting functions. Additionally, commonly used control key combinations are available such as CTRL+X, CTRL+C, and CTRL+V for cut, copy, and paste respectively for PC.

Toolbar Functionality

Each toolbar is organized into three rows and each row has groups of functionality. In the WYSIWYG, the groups are divided by a vertical line on-screen. The behavior of the icon is specific to the functionality of the tool. For example, some functionality such as the link tool requires text or another type of content to be selected before it is available on the toolbar. Other items on the toolbar include icons that are unavailable until the main feature has been inserted on a page. For example, the Insert/Edit Table icon will be available, but the other table editing tools such as those to define row properties or delete a column are not available until a table has been inserted on a page. Some items such as the Insert/Edit Image icon or spell check, when clicked, provide a dialog with a much more underlying functionality than is readily apparent. One last type of element that might be available on the toolbar are several drop-down selectors that provide the ability to style text.

One item that is not represented on the toolbar, but is available from within the WYSIWYG is the ability to save-in-place (CTRL+S or CMD-S). This offers users the ability to save the page without clicking the usual save icon that ends the editing session. Save-in-place saves the page and allows the user to continue editing.

Toolbar Row 1

Toolbar Row 1 Overview

Most of the tools available on the first row of a toolbar for the WYSIWYG are basic text formatting and linking.
The tools are on row 1 of the toolbar are:

- Save, Save As, Revert, Restore
- Cut, Copy, Paste, Find, Replace
- Undo/Redo
- Toggle Spell Checker
- Remove Formatting
- Font Formatting
- List, Indents
- Text Placement (Vertical)
- Align, Justify (Horizontal)
- Link Tools, WYSIWYG Help Documentation

WYSIWYG Spell Check

**WYSIWYG Spell Check Overview**

Within the OU Campus™ WYSIWYG Editor there is a built in spell checker. Currently the spell checker supports five languages, each with its own custom dictionary. The current languages supported are: English, Spanish, French, Italian, and Portuguese. These are the same custom dictionaries that are used during Page Check and/or Final Check. The WYSIWYG Spell Check feature checks the spelling for the editable region that is open in the WYSIWYG. This differs from the Page Check/Final Check spell check, which performs the spell check on the complete page prior to being published.

**Correcting Misspelled Words**

Misspelled words are identified with a wavy, red underline.

1. Click the Spell Check icon from the WYSIWYG Editor toolbar. The default language will be used to spell check the page. However, if the page should be edited in another language click the downward facing arrow portion of the split button and select another language.
2. Click on a word identified as misspelled. This displays a list of words that may be selected to replace the misspelled word and other options.
3. Select one of the suggested words or, one of the other options. Other options are:
   a. Ignore word: Allows just the current instance of the word to not be marked as misspelled
   b. Ignore all: Allows all current instance of the word to not be marked as misspelled

**Insert/Edit Link**

**Insert/Edit Link Overview**

The Insert/Edit Link tool provides the basic functionality to add a hyperlink within the WYSIWYG Editor. Links are created by highlighting text or an image, clicking the Insert/Edit Link icon, and specifying the Link URL. The Insert/Edit Link icon is dimmed until the text or image to be hyperlinked is selected. Links can point to internal web links, external websites not maintained in OU Campus, or other pages within
OU Campus. The Insert/Edit Link icon can also be used to create links to files, such as PDFs. In addition to providing the basic functionality for creating and maintaining links, this tool provides more advanced functionality relating to linking including linking to anchors, and specifying targets.

Links and Dependency Manager
It is possible for links to pages or directories maintained within OU Campus to be updated automatically when the page or directory to where the link is pointed is moved or renamed. The links are tracked by Dependency Manager. When Dependency Manager is activated, it is important to browse for the appropriate page in order to ensure that the link will be updated if the target page, directory, or other content is moved or renamed.

Dependency Manager can be configured to manage links both within a site and across sites within an OU Campus account. However, it does not manage links to external websites such as CNN. If Binary Management is in use for the site or sites, binary files such as PDFs and images are also managed.

Example of a Dependency Tag

Inserting an Internal Link (Typical)

1. Within the WYSIWYG Editor, select the text or image for the link.
2. From the toolbar, click the Insert/Edit Link tool.
3. Click the Browse icon to select an internal page to which to link.

The Insert File Link modal is shown.
4. Select a file to which to link. For links to pages internally, a page should generally be chosen from the production server. The production server is selected by default; otherwise select a different target or server from the drop-down.
   - To upload a file and link to it, click Upload and either Add Files or drag files from the local computer.
5. After locating the file, click Insert. Other configuration options for a link are also available before inserting the link; for example, entering a Title or selecting a Target window/tab for the link to open in. The Title is both valuable and important as this is used by screen readers and helps keep the site in compliance with accessibility compliance standards.
6. Click Insert.

Linking to an External Page
The steps are the same as the procedure outlined in the Inserting an Internal Link (Typical) heading, but rather than browsing for the internal link the complete URL for the resource can be typed (or pasted) into the URL field. Links to external pages are not under Dependency Manager tracking.

Specifying a Link Target
The steps are the same as the procedure outlined in the Inserting an Internal Link (Typical) heading, but the target is chosen from the Target drop-down on the General tab.

As a general rule, when inserting a link to another page on the institution's website, the link should open
in the same window. When inserting a link to a page outside the institution’s website, or to a PDF, or other similar file, the page should open in a new window. The options for the Target field include:

- Open in This Window/Frame: Linking to pages on the institution’s website
- Open in New Window (_blank): Linking to pages on another site or binary files
- Open in a Parent Window/Frame (_parent): Used with framesets
- Open in Top Frame (Replaces All Frames) (_top): Opens a page in the topmost parent frame

**Toolbar Row 2**

**Toolbar Row 2 Overview**

The tools are on row 2 of the toolbar are:

- Font Properties (Family, Size, Format, Styles)
- Text Color, Text Background
- Images/Media
- Miscellaneous Functionality

The Font Properties drop-downs and the selectors for text color and highlight color can be toggled on and off. For example, if the Format drop-down was used to apply Heading 2, the use of Heading 2 can be deactivated by deselecting it in the drop-down. Formatting applied with the use of the Styles drop-down, and those for selecting text color and highlight color can also be cleared with the use of the Remove Formatting tool, which is represented by the Eraser icon on the toolbar.

**Insert/Edit Image**

**Insert/Edit Image Overview**

The Insert/Edit Image tool provides access to a plenitude of functionality related to images, image management, and code markup for images. At the very simplest, it can be used to link to an image and provide a description for it, which is required. On the other hand, Insert/Edit Image can also be used to:

- Upload and use the Image Editor
- Browse to an image that was previously uploaded to link to it
- Provide meta data about an image in the form of an Image Description (alt tag) and Title (title tag)
- Preview an image
- Align an image
- Add space or a border around an image

When using the Insert/Edit Image tool, once an image has been selected for insertion on a page, the WYSIWYG Editor seamlessly provides the HTML mark-up for the link behind the scenes.

In addition adding an image link to a page, the Insert/Edit Image tool includes the Appearance tab. The
Appearance tab provides the ability to modify the appearance of the inserted image with CSS, but without having to know CSS or directly interface with CSS syntax.

**Inserting an Image**

1. To insert an image, click the Insert/Edit Image icon. This shows the Insert/Edit Image dialog.

2. Click the Browse icon to browse to the image.

The Insert Image modal is shown. The picture folder opens and displays thumbnail images to preview.
3. Several navigation avenues are available for selecting an image:
   - Choose an alternative publish target, or the staging server if Binary Management is in effect, and browse to the location
   - Expand a directory and click an available thumbnail image preview
   - Upload an image

4. Once the image has been selected, click Insert.

5. From the Insert/Edit Image dialog, enter a value for the Image Description field.

6. Click Insert. The image is shown in the context of the page within the WYSIWYG Editor.
Editing an Inserted Image
The details of the image can be modified after insertion on a page by clicking the same Insert/Edit Image icon, making the necessary edits, and clicking Update.

Uploading an Image from the WYSIWYG
A file can be uploaded by browsing the local computer or by dragging to the dialog. Both methods allow for selecting multiple files for upload at one time.

Dragging a File to Upload
1. As described above, click the Insert/Edit Image tool, and the Browse icon.
2. From the Insert Image dialog, click Upload.
3. Drag the file or files to upload from the local computer to the dialog.
4. Alternatively, click the Add Files button to browse and select local files.

5. The ability to overwrite files is available by clicking the Overwrite checkbox.
6. Files may be renamed at this point by clicking Rename, entering the new file name, and clicking OK. Make sure that you follow the correct naming conventions for the file names.

7. Click Start Upload to upload the files.

During the upload the status is shown as In Progress, and when completed, as Done. If a file could not be uploaded, which may be the case if it does not follow file naming conventions configured by the site, the status message indicates an error and the file is not uploaded.

8. Click Close when finished.

Example of Successful File Upload
Image Editor Tools
The Image Editor has a predefined set of tools that allow users to customize images as they wish.

1. Click the Upload icon in the Pages list view.
2. In the Upload dialog, select Upload and Edit Image.

3. This automatically opens the local computer’s File Explorer (PC) or Finder (Mac). Locate the file and click Open.
4. The image is opened in the Image Editor where changes can be made to the file.

5. When all the changes have been made, click Upload.
6. A dialog will appear. Enter the New File Name for the file, including the extension, and use the browser to Select Destination Folder. If needed, select the checkbox for Show Files.
7. Click Save.

The user is returned to the Pages list view inside the folder where the image was uploaded.

Upload and Edit Image

Upload and Edit Image Overview
An image can be edited and uploaded from the Upload To dialog within the Pages list view of OU Campus or while you are editing the page within the WYSIWYG editor.

Selecting and Uploading the Image

1. From the Pages list view, click the Upload icon.

2. For Upload Type, choose Upload and Edit Image.

3. Select the image file from the local computer for uploading and editing.

4. This displays the Edit Image panel with the image.
5. After utilizing any necessary editing functionality, click Upload to upload the image.

Editing the Image

The following functionality is available on the Tools menu:

- Resize
- Crop
- Rotate
- Zoom
- Undo
- Redo

Resize

The Resize tool includes the ability to specify a new width and height for an image to upload. The original ratio for the dimensions of the width and height for can be kept intact by selecting the Preserve Ratio checkbox.

Crop (Custom)

The Crop tool can be used to reduce the dimensions of the image by either selecting a ratio or by determining a custom crop size by manipulating the crop box by dragging the crop handles located on the edges of the crop box.
Rotate

The Rotate tool rotates the image (edited and unedited) 45 degrees in a clockwise direction with each click.

Zoom

The Zoom tool can be used to manually enter a percentage of the original image size to be displayed in the Edit Image panel for editing. The plus and minus magnifying glass buttons may also be used to increase or decrease the viewing size.

The Original button reverts the image to the original size.
The Zoom to Fit button resizes the image to fit into the panel for viewing.
Undo/Redo

The Undo and Redo functionality is available after performing another editing function.

Image Editing from Pages List View

Any image file can be edited from the Pages list view. The image editor can be used to edit images already uploaded to the production server.

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Hover over the target row and click Edit, or click the hyperlinked image name.
3. The Image Editor will open and the image can be modified.

Editing Images in WYSIWYG Mode

To edit any image while using the WYSIWYG editor, click the Insert/Edit Image icon in the WYSIWYG toolbar. Any image can be selected and edited using the Edit Image button in the file selector window. Additionally, users can upload and edit any image from this same window by clicking the Upload button.

1. Click the Insert/Edit Image icon on the WYSIWYG toolbar.

2. Click the Browse icon to change or edit an image.

3. Expand a folder or double-click to view thumbnails of all the images contained within that
folder. Click a thumbnail to show a preview of just the selected image.

4. Choose one of the following actions:
   - Click the Edit Image button to edit the file displayed in the Image Preview window.
   - Click the Upload button to open, edit, and upload a file from a local computer.
   - Click the Upload & Edit button to upload a file from a local computer and start the Image Editor.

**Media Editor**

**Insert/Edit Embedded Media Overview**

The Insert/Edit Embedded Media button is a tool in the WYSIWYG Editor that allows users to include video on a page and can be accessed from any page so long as the file is checked out to the user. Users can add media from external sources. To access the Insert/Edit Embedded Media button, select Content > Pages from the global navigation bar and open any page for editing. When the user clicks Insert/Edit Embedded Media, a dialog opens which includes the General Tab: This tab allows users to upload the file and change basic metadata information about the file.

**General Tab**

The General Tab of the Insert/Edit Embedded Media dialog allows users to upload video files and change basic metadata information about the file. Currently, users can select from HTML5 Audio, HTML5 Video, Flash, Transcode It, Quicktime, Shockwave, Windows Media, Real Media, and Iframe as the desired file types. When a user opens the General tab, the following elements are displayed:
• Type: This drop-down menu allows users to select the type of file they will be importing.
• File/URL: Users browse for the file on their desktop using this parameter.
• Dimensions: Allows users to edit the dimensions of the file and how it will render on the page.
• Preview: Displays a preview of the file that is being imported.

Inserting Embedded Media

Users can insert embedded media files from external sources, such as Youtube or other similar video-sharing services.

1. Locate the video on an external video sharing service such as Youtube.
2. Copy the URL for the video from the top address bar.
3. Return to the page in OU Campus where the video should be placed, and place the cursor at the location where the video should be displayed.

4. Click on the Insert/Edit Embedded Media icon in the WYSIWYG toolbar.

5. Paste the file’s URL into the File/URL box.

6. Fill out the necessary fields in the General tab.

7. When complete, click Insert.

The media does not render within the WYSIWYG Editor. Instead a yellow placeholder box the size of the intended media is displayed. Once the page is saved, the video renders in the preview.

**Toolbar Row 3**

**Toolbar Row 3 Overview**
The available tools on the third row of the toolbar are those available for inserting and editing tables within the WYSIWYG Editor. The additional features are available after the initial table has been inserted on the page. Place the cursor within the element and the editing tools will become available. Use tables sparingly – if you need to use tables for lay out purposes please contact us at cms@etsu.edu.

In addition to the Insert/Edit Table tool, other table editing functions include those for defining the properties for table cells and rows, and for inserting and deleting rows and columns.

As with other functionality, right-clicking within a table provides a shortcut menu for table editing and formatting.
Table Tools

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Insert/Edit Table icon](image1) | Insert/Edit Table     | To insert a table, position the cursor then click the Insert/Edit Table icon. The Insert/Edit Table dialog includes several fields that can be used to define the table including:  
  - Columns: Number of columns in table  
  - Rows: Number of rows in table  
  - Cell Padding: Padding around cells  
  - Cell Spacing: Spacing between cells  
  - Alignment: The alignment of the content within the cells  
  - Border: Thickness of the border around the cells  
  - Width: Width of table  
  - Height: Height of the table  
  - Class: A class defining the styling of the table  
  - Table Caption: Choose whether or not to have a caption above the table  
  Fill in table details, then click OK to insert table, or click Cancel to return to the editor. |
<p>| <img src="image2" alt="Table Row Properties icon" /> | Table Row Properties  | Edit the alignment, background color and several other properties of the rows of the table.                                                                                                                |
| <img src="image3" alt="Table Cell Properties icon" /> | Table Cell Properties | Edit the alignment, background color and several other properties of the cells of the table.                                                                                                              |
| <img src="image4" alt="Insert Row Before icon" /> | Insert Row Before     | To insert a row above another row, click inside the row cell the new row is to precede, then click the Insert Row Before icon.                                                                            |
| <img src="image5" alt="Insert Row After icon" />   | Insert Row After      | To insert a row below another row, click inside the row cell the new row is to follow, then click the Insert Row After icon.                                                                                |
| <img src="image6" alt="Delete Row icon" />         | Delete Row            | To delete a row, click inside the row to be removed, then click the Delete row icon.                                                                                                                      |</p>
<table>
<thead>
<tr>
<th><strong>Insert Column Before</strong></th>
<th>To insert a column before another column, click inside the column cell the new column is to precede, then click the Insert Column Before icon.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Insert Column After</strong></td>
<td>To insert a column after another column, click inside the column cell the new column is to follow, then click the Insert Column After icon.</td>
</tr>
<tr>
<td><strong>Delete Column</strong></td>
<td>To delete a column, click inside the column to be removed, then click the Delete Column icon.</td>
</tr>
<tr>
<td><strong>Split Merged Table Cells</strong></td>
<td>To split cells that have previously been merged, select the cell then click the Split Merged Table Cells icon.</td>
</tr>
<tr>
<td><strong>Merge Table Cells</strong></td>
<td>To merge cells, highlight the cells to be merged, then click the Merge Table Cells icon.</td>
</tr>
</tbody>
</table>

### Recycle & Restore

**Recycle and Restore Overview**

In the context of OU Campus when the recycle bin is enabled the following functionality is available:

- Move to Recycle Bin: In other words, moving a file to the recycle bin is recycling it. A file moved to the recycle bin can be restored from the recycle bin.
- Restore: A file can be restored from the recycle bin.
- Delete: Files can be permanently deleted from the recycle bin after being moved to the trash. A directory can only be deleted, as no recycle functionality is available for a directory.

### Moving a File to the Trash

1. From the Content > Pages view, hover over the menu bar for a file and from the File menu choose Move to Recycle Bin.
Alternatively, a page can be selected by clicking the adjacent checkbox, and Move to Trash is made available.

2. The resulting dialog warns that the selected file and any derivatives on production will be deleted. When the recycle functionality is enabled for a site, pages on the staging server must be recycled before they can be permanently deleted. A recycled page or file can also be restored from the recycle bin if necessary. After a page has been restored, it must be re-published to the production server. When a page is recycled on the staging server, the published derivatives are automatically deleted from production servers. Likewise, a file can also be solely deleted from the production server or other publish target by navigating to the Production button or button for the publish target, and deleting it. The recycle bin functionality does not extend to these servers. Once a file is deleted from the production server or publish target, it cannot be restored. It can be re-published from the main file on the staging server with any routine form of publishing, such as publish, site publish, directory publish, or scheduled publish.
3. Click Move to Recycle Bin. The files are moved to the trash.

Note that a page or file checked out to another user or that has been scheduled for an action by another cannot be moved to the recycle bin.

**MultiFile Recycle**

Multiple files can be recycled with the same action by selecting the checkbox in the header row of a list or each checkbox adjacent to the file name and clicking Move to Recycle Bin. Note that when performing a multi-object selection that includes directories, only Delete is available as directories cannot be recycled. Using a multifile section can be useful to simulate a directory recycle, as in this manner, all files within a directory can be selected for moving to the recycle bin, which will then allow the files to be restored, if necessary.

Note when selecting multiple files and a page or file checked out to another user or that has been scheduled for an action by another is included in the selection, Move to Recycle Bin is not available as it is not possible to recycle those pages.

The resulting dialog enumerates how many files will be moved to the trash and warns that derivative files on production will be deleted.

**About the Recycle Bin**

The recycle bin is only for files on the staging server. Files deleted from the production server that do not have a direct counterpart on the staging server are deleted permanently and are not recoverable. When a file is sent to the recycle bin on the staging server, the file and all of its version history as well as its path and access rights are all moved to the recycle bin. All files that were created on the production server from the file being sent to the recycle bin are permanently deleted from the production server.

The recycle bin is not meant to be used as an archive. If a file is sent to the recycle bin, and later the directory is deleted, if the file is selected to be restored, the original path to the file is recreated and the file moved back. None of the access properties that may be necessary to publish the page will exist as they are stored with the directory, and the original directory was deleted. The access settings and/or directory variables will need to be set by the administrator in order to manage or publish the file.

**Restoring a Page from the Recycle Bin**

A singular file can be restored from the trash or multiple files can be restored.

1. To view the contents of the trash, hover over content in the Main Navigation Menu Bar and select the Recycle Bin.

2. The Trash screen is displayed. The screen can be sorted on the following columns: file type, Name, Original Location, and Delete Date. The list can also be filtered by name.
3. Hover over the menu bar for the file and in the Options column choose Restore.

Alternatively, a single file or multiple files can be selected by clicking the adjacent checkbox, or multiple files can be selected by clicking the checkbox from the top row.

4. Click Restore

Review

Review Overview

Several items of functionality exist within the OU Campus content management system to assist in the review of pages and other content. Within this category, information is provided specific to the review of pages, including utilizing a workflow process for approval of the content of pages. While the information is specific to pages, the review of content throughout the system for other types of content, specifically assets and if applicable binary files, is very similar to the information provided here. Users can review content either from the Pages list view or from the Page Actions toolbar. For Assets, review options can be selected from the Assets list view or the Asset Actions toolbar.

The options available in the Review menu are dependent on user permission level as well as the current status of the content. Content that is not checked out will have
fewer options available. Pages that are not checked out will only have the following options available by default:

- Preview
- Log

On the other hand, content that is checked out displays the following options by default:

- Preview
- Page Check
- Save Version
- Versions
- Log

Not all users will have the same permissions and therefore will not all have the same options available even if the content is checked out.

**Preview**

Prior to checking out or editing a page, a page can be previewed. This view provides limited functionality in that no buttons are available for editing, saving.

**Navigating Preview**

Preview can be navigated from the folder structure viewable from Content > Pages or from DirectEdit log in. Pages can be previewed whether it is checked out to the current user or not, and users can preview files checked out to others. Immediately after editing and saving a page, a rendered preview is displayed, with the option to see a preview in other browsers. It is possible to navigate to the preview at any time using the Preview button.

**Page Preview from Content > Pages View**
Page Check

Page Check is an account-wide feature with several customization options that can be applied at the account, site, and even user level. Because of the flexibility of the implementation of the various quality assurance checks that can be run on a page, the available options described here may vary for an institution's implementation. The four basic types of checks available with Page Check are:

- Spell Check
- Link Check
- W3C Valid

Depending upon configuration, the Page Check can be initiated while in preview or edit mode for a checked-out page, while editing a page, or at the time of publish. All of the four quality checks may be enabled to run or any combination of the available checks may be enabled to run.

Initiating Page Check

**From the Folder Structure (Content > Pages)**

1. Navigate to Content > Pages and check out the desired page.
2. Hover over the menu bar and Review menu, and choose Page Check.

**From Preview, Edit, or Editing**

1. When the page is checked out, the Page Check icon is available in the page actions toolbar.
2. Click Page Check icon.
As Final Check

If in addition to Page Check, Final Check is enabled (and perhaps even required), then initiating a publish will either make the enabled page checks available, or run them automatically.

![Publish index.pcf](image)

Save Version

During the review process, or veritably at any time, a user or reviewer can commit a version of a page, and later if or when necessary, revert to a previous version of a page. The current state of a page on staging can be compared with the current published version of a page or with previous versions of a page. The resulting comparison includes color-coded markup indicating how the pages differ.

Versions

The Versions tool allows users to access and review previous saved versions of content on the staging server and allows for comparison between versions, including the version on the production server.

A unique version of a page is saved through the automatic version control system every time a page is published. A backup version of a page can also be created at will with the use of the Save Version button. It can be useful to create a permanent version or backup of the page before extensive editing. It is also important to note that any version descriptions or publish notes added at the time of page publish are shown in the Description column.

The Versions screen shows this list of saved versions of a page. It can be accessed from the folder structure or while previewing or editing a page. Before navigating from editing a page to viewing versions, the page should be saved. The Versions screen:

- Shows the number of versions saved for the page
- Shows a sortable list of versions, which includes the revision number for the page, the date it was saved, the page author, the version description given with the save or publish, and other
Options

- Allows for comparing the current staging version to the current production version
- Provides a method for saving another version of the page
- Allows for reverting to a previous version of the page

Example of Versions Screen

Saving a New Version

Although a unique version of a page is saved in the OU Campus automatic version control system every time a page is published, users can also create a version at any time. For example, after editing and saving a page several times, a user may wish to create a permanent version or backup of the page before moving on with further edits such as a find and replace. When editing a page, the Save Version button is available for this purpose. The Save Version button is also available in Preview mode.

1. To save a version of a page, either:

- Preview a checked out page, or enter into the Edit mode of a checked out page. Click on the Save Version button in the Page Actions Toolbar.

- Enter the Pages List view and check out the desired page. Hover over the Review menu and select Save Version.
2. This opens the Save Version dialog. If so desired, click the linked current state text to see a preview of the page as it exists on staging.

3. Although optional, it is recommended to enter a bit of descriptive text for the version. This can be viewed from the Versions screen and can be a useful clue in the future if it is necessary to determine that a page should be reverted and to which version it should be reverted.

4. Click Save Version. A success message is displayed briefly.
Navigating to Versions

From the Folder Structure

The Versions screen can be accessed from the Pages list view of the site.

1. Navigate to the Pages list view and check out the desired page.
2. Hover over Review on the page row and choose Versions. This displays the Versions screen.

From Preview or Edit

The Versions screen can also be accessed while in Preview or Edit mode, or while editing a page with the WYSIWYG Editor. Note that the page must be checked out to the current user.

1. Check out a page and view the page in Preview or Edit mode.
2. While viewing the checked out page, click the Versions button. This displays the Versions screen.

Filtering Versions

The Versions list can be filtered by entering characters in the Filter field. The filter is relevant to the Revision, Author, and Message columns, and items with matching character strings are displayed in the list. The rest are hidden until the filter is removed, which can be accomplished by clicking the circle-x icon. Filtering can be used to help locate a specific version of a page.

Viewing a Revision

From the Versions screen, a version of the page can be viewed and the source can be viewed. These views of a page version are provided in a separate browser window or tab.
Viewing a Page Version
From the Versions screen, hover over the row for the version and from View, select Page. The page is displayed.

Reverting to a Version
The Versions screen includes the ability to revert to a previous version of a page.

1. From the Versions screen, hover over the row for the version and click Revert.

2. The confirmation dialog is shown.

Revert /admissions/index.pcf to revision 2

Are you sure you want to revert this file? This action will replace the current file on the staging server with revision 2 of /admissions/index.pcf

3. Click Revert.
4. A success message shows to which version the page was reverted.

Note: The page must be published to the production web server to make it live on the www.

Log
In addition to the built-in versioning system, the system also maintains a log file for a page. This displays all of the saves and publishes, whether manual, scheduled, or if it was part of a directory publish, that have occurred for a specific page.

Support Specialist: Sherry Martinez
(martines@etsu.edu) 98249
Publishing a Page

Publishing a Page Overview

Pages and other content within OU Campus are edited on a staging server. They must be published in order to be viewable on the World Wide Web. Publishing a page or other content can be as simple and easy as clicking the Publish Now button. There are quite a few other features related to publishing that may or may not be enabled for a site.

Additionally, at the time of publish various qualitative reviews of a page such as to check the spelling, check compliance to an accessibility standard, checking for broken links, and to validate to the W3 standard for HTML can be configured by an administrator to run automatically before publish.

Binary file types also must be published to the production server if under management with the Binary Management and Dependency Manager features.

Publishing a Page

A page may be published in any of three ways:

1. A page can be published immediately after editing and saving the page by clicking the Publish button in the page actions toolbar. The button is only shown if the user has publishing rights.

2. A checked-out page can be published by navigating to the Pages List view and hovering over Publish on the page row, which is only shown if the user has publishing rights.
3. Multiple pages can be selected for simultaneous publish. Simply check the boxes in front of the pages to be published, and click the Publish option at the top of the page list view.

Clicking the Publish button displays a publish dialog. Within this screen the following tools may be found:

- **Final Check**: This tab includes a set of checks that can be run manually by the user or can be set to automatically run by the system administrator.
- **Run All**: Click to run all available checks on the spelling, links and W3C Valid output.
- **Spelling**: Checks the spelling on a page in the given language selected in the Spell Check Language box.
- **Links**: Checks for broken links on the page.
- **W3C Valid**: Checks a page for valid HTML and XHTML markup, depending on the schema setting.
• **Publish Target**: If available, a publish target other than the production server may be selected.

• **Version Description**: This will allow a version description to be included in order to indicate what was updated and why the page is being published. This can be used when choosing previous versions in which to revert.

• **Schedule**: This tab allows for a scheduled publish, rather than an immediate publish of the page. A user can select the date and time of publish, and choose to repeat the publish according to a schedule if desired. A user is also notified of publish, and can choose to be notified in the user's OU Campus Inbox only or also to the user's external email.

• **Social Media**: This tab provides options for the user to include a publish to Twitter or Facebook with the page publish. A shortened URL for the page can be added by clicking the Add URL link beneath the respective social media fields.
  
  - Twitter: If one or more Twitter accounts have been configured, the system sends a tweet to the selected Twitter accounts upon publish. A shortened URL can be added that directs to the published page. Tweets may be up to 140 characters in length.
  
  - Facebook: If one or more Facebook pages have been configured, the system sends a post to the selected Facebook pages upon publish. A user may add a shortened URL that directs to the published page. Posts may be up to 420 characters in length.

• **Publish**: Allows a user to publish the page.

**Selecting a Publish Target**

The defined publish targets are available in a drop-down menu.

![Publish Target Dropdown](image)

When within the Pages view of the site, the available servers, including the staging, production, and additional publish targets, are shown in tab view.

![Publish Targets in Tab View](image)
Viewing the Publish Notes

Once a file has been published, the version description can be viewed within the versioning system. To view the notes, check out a page from Content > Pages. Hover over Review on the page row and choose Versions. This will present a log of the publishes and backups, including any messages.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>User</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 (Live)</td>
<td>8/14/2013 2:55 PM</td>
<td>jculton</td>
<td>Live on publish target: Gaitena_University</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>8/14/2013 2:51 PM</td>
<td>jculton</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>8/3/2013 12:00 AM</td>
<td>jculton8</td>
<td>OU Campus Publish Notification</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>6/26/2013 9:43 AM</td>
<td>jculton</td>
<td>Version notes test</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>4/29/2013 2:19 PM</td>
<td>zz-omniupdate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Final Check

Final Check Overview

Final Check gives a content contributor the capability to perform a series of quality assurance tests on a page before publishing. These include spell checking, link checking, W3C validation, and/or accessibility compliance.

Running Final Check

Final Check is not configured to run automatically, click Run All to run all checks, or click any of the enabled checks to selectively run checks.

Example of Spell Check Errors

Support Specialist: Sherry Martinez
(martines@etsu.edu) 98249
Schedule

Schedule Overview
When users want to publish content, but wish to do so at a later date, they can utilize the Scheduled Publish tool. A scheduled publish can only be canceled or modified by the user who set the schedule or a Level 9 or 10 administrator. The Schedule Publish tab is part of the Publish dialog, which can be accessed from the Pages list view by selecting Pages > Content from the global navigation bar.

Schedule Tab
When users select the Schedule tab of the Publish dialog, the following elements are displayed:

- **Date**: The target date the user wants the page to publish on.
- **Time**: The time at which the scheduled publish will take place.
- **Repeat Every**: Allows users to repeat the publish by specific amounts of time using the text field and drop-down selector.
- **Subject**: Optionally, users can send an external email in addition to the internal OU Campus message. This field lets users add a subject line to that email.
- **Message**: Allows users to include a brief message about the publish in an external email.
• **Also Email Me:** If selected, the option sends an external email to user in addition to the internal OU Campus message.

After a Scheduled Publish has been performed, the content's status will change in the Pages list view. A green calendar icon indicates that the page is checked out to the current user because the user has scheduled a publish to occur. Other users' scheduled publishes will appear as red calendars.

<table>
<thead>
<tr>
<th>File</th>
<th>Size</th>
<th>Last Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>landing.pcf</td>
<td>1.6K</td>
<td>12/5/2013 9:46 AM</td>
</tr>
<tr>
<td>left.pcf</td>
<td>2.4K</td>
<td>12/5/2013 9:46 AM</td>
</tr>
</tbody>
</table>

**Performing a Scheduled Publish**

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Hover over the target item's row and select Schedule from the Publish menu. Additionally, navigating to a view that displays the Page Actions toolbar and selecting Schedule from the drop-down menu on the Publish button will accomplish this.
3. Click in the Date text field to display a calendar widget and select a date. Users can scroll through the months of the calendar using the arrows at the top of the calendar.
4. Click in the Time text field to display a time selector and set the target date for the publish.

Support Specialist: Sherry Martinez  
(martines@etsu.edu) 98249
5. In the Notification section, a checkbox may be selected to Also Email Me. This sets an optional notification email that can be sent when the page is published. If selected, fill out the fields in the Notification section.
6. If preferred, select the Final Check tab and run any tests necessary before publishing.
7. Click Schedule.

When the page is published, the notification email is sent through workflow, and if the option checkbox was utilized, through external email.

Removing a Scheduled Publish
A Scheduled Publish can also be removed from content. If a user attempts to immediately publish content that is already scheduled for publishing at a later date, they will be unable to perform this action until the Scheduled Publish assignment is removed. To remove a Scheduled Publish:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Click the green calendar icon on the target item’s row to display the Remove Publish Schedule dialog.
3. Click the yellow Remove Schedule button to cancel the scheduled publish.
To remove the Scheduled Publish using the Page Actions toolbar:

1. Preview the scheduled page, or by using the My Current Pages gadget.
2. Click the Unschedule Publish button in the Page Actions Toolbar. A dialog will appear.
3. Confirm by clicking Remove Schedule. When the page is published, the notification email is sent through workflow, and if the option checkbox was utilized, through external email.

New Content/Web Pages

New Content/Web Pages Overview
Content can be created and managed within the Pages list view of the CMS. By navigating to Content>Pages, a user with the proper authority may create new pages, sections, and folders. The system is configured with templates, which are utilized to create new sections and pages. These templates allow for the pages to be configured uniformly and have a consistent look and feel.

The options available for creating new content are:

1. Create a New Folder. Folders are for binary files and are not the same as creating a new directory. A folder can be created to contain binary files, such as images and PDFs. A folder can only be created from the drop-down indicator, and not from clicking the New button.
2. Create a New Section. The New Section option creates a new content-based directory. The new section template will contain all of the necessary files to make the pages within the new directory render correctly. When creating a new section, navigate to the parent directory where the new section will be contained. If New Section does not appear, contact the administrator.
3. Create a New Page. A new page can be created by clicking on the appropriate template for the type of page. Note that administrators can restrict the type of templates available for the directory, and that users may not have a choice in template type.

Creating a New Page

Creating a New Page Overview
A new page can be created from existing templates within the OU Campus system by accessing the Pages list view. The Pages list view can be accessed by selecting Content > Pages from the global navigation bar. Pages should be created from within the appropriate directory to avoid needing to move pages and accidentally creating broken links. Users have access to the following screens during the new page creation process:

- Select New Content: Allows users to select a template from the local templates directory in the account.
• New (Template Name) Page: Users customize basic metadata information about the new page from this screen.

New Page Creation Options

A new page can be created from the Pages list view by using the New button.

Users can additionally click the drop-down indicator on the New button to display the available templates.

The New button and the drop-down indicator can both be used to create a new page, but reveal different styles of menu. The drop-down indicator reveals a menu within the directory structure.

Select New Content Screen

When users either click the New button or use the drop-down menu on the New button, the Select New Content screen is displayed. Users click one of the Template Icons to open a dialog for editing the new page properties using the selected template. The elements displayed include:

• Template Icon: Provides users a thumbnail icon, usually depicting the functionality of the template associated with the image.
• Template Name: Provides the TCF file name for the template as it appears in the OU Campus system.
New (Template Name) Page Screen

Users fill out all necessary parameters in this dialog to create a basic page with no content. Users utilize the WYSIWYG Editor to create custom content to include in the page.

Creating a New Page

To create a new page in the OU Campus system:

1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.
2. Click the New button, or use the drop-down menu.
3. Select the type of page to be created.
4. Fill out the New Page information in the displayed dialog.
   a. Fill in the following fields: Browser Tab Title, Breadcrumb Text (10 characters or less), and the Page Heading. These fields **HAVE** to have content.
   b. Select the Page Layout – one column or two unless you have selected the Home page template – then your selections will be: three column, two column or two column offset.
   c. Under options – remove the untitled BUT leave the .pcf and name your page – use only lowercase, underscores and numbers – No spaces. Keep your page name short – it will be part of your url.
   d. Ignore the Overwrite Existing and the Access Group – these default correctly.
5. When the information is completed, click Create.
Dashboard

The OU Campus Dashboard provides a location within the CMS where each individual can access user-specific messaging and gadgets. The Dashboard can be customized by each individual user by choosing which gadgets to show or hide in the view. The user can also modify the appearance by dragging a gadget to reorder the view.

Inbox

Inbox displays messages from other users as well as automated messages associated with scheduled actions, such as a notification of scheduled publish or notification of page expiration. The Inbox includes a linked list of messages and the functionality to compose a message.

Configure Dashboard

The available features and functionality of the Dashboard are as follows.
Once specific Dashboard gadgets have been configured to be available for a group of users, members of the group can choose which gadgets to show on the main content area. The Configure Dashboard feature can be used by each individual user to choose which gadgets to show in the main content area.

Frequently displayed gadgets include an activity feed of recent site activity, the system inbox for messaging and notifications, a list of pages that are currently checked out by the user, and site analytics.

Dashboard gadget can be reordered by clicking the gray title bar and dragging to the new location.

**Gadgets**

**Gadgets Overview**

All user levels have the ability to choose which available gadgets to show on the Dashboard as well as on the Gadgets sidebar since these are configured separately. Dashboard gadgets can be chosen to be shown or not by clicking the Configure Dashboard link on the main content area of the Dashboard. The Gadgets sidebar includes the Choose Gadgets button so that a user can

**Dashboard Gadgets**

Frequently displayed gadgets include system gadgets that provide the functionality for an activity feed of recent site activity, the system inbox for messaging and notifications, a list of pages that are currently checked out by the user, and site analytics. These provide the user a thumbnail view of content, messaging, and the ability to navigate to the content items. For example, the system gadgets illustrated in the screenshot below are as follows:

- **My Current Pages**: Shows the content checked out by the current user and the date/time stamp that the content, which can be a page, asset, or file, was checked out. Within this gadget, the pages are linked and can be clicked to for editing or approving. The light bulb icon indicates the page is checked out and clicking the icon checks the page back in.

- **Activity**: Activity shows content with recently performed actions such as a scheduled publish, expire, or upload.

- **Inbox**: Provides a scrollable list of recently received messages.

- **Site Analytics**:
Configuring the Dashboard

The Configure Dashboard link can be used to choose which gadgets to display on the Dashboard. Every user level has access to this functionality.

1. Click Configure Dashboard. This displays the Choose Dashboard Gadgets modal to view the gadgets available to the user.
   - A gadget with a checkmark indicates it is being shown on the Dashboard.
   - A gadget without a checkmark indicates it is not being shown on the Dashboard.
2. Click the gadget box to either select or deselect the gadgets to show on the Dashboard.
Gadgets Sidebar

The Gadgets sidebar is a global element and can be shown or hidden by the user. The sidebar exemplifies responsive design as the sidebar also automatically collapses or expands when a browser is resized. The Gadgets sidebar can be expanded by clicking on the Show Gadgets button at the top right of the screen.

Once the Gadgets sidebar has been expanded additional functionality is available; including the ability to choose which gadgets to show, to expand all, and to expand and collapse specific gadgets.
When the Gadgets sidebar is expanded each individual gadget can be expanded and used according to its functionality.

**Expanded View**

Gadgets sidebar may include the following system gadgets by default:

- **DM Tag Info**: Search functionality for dependency manager tag that reports information about the tag. Valid search syntax is shown below the field.
- **My Current Pages**: Shows the content checked out by the current user and the date/time stamp that the content, which can be a page, asset, or file, was checked out. Within this gadget, the pages are linked and can be clicked to for editing or approving. The light bulb icon indicates the page is checked out and clicking the icon checks the page back in.
- **Notepad**: Allows for taking notes. Notes can be shared among users.
- **Activity**: Activity shows content with recently performed actions such as a scheduled publish, expire, or upload.
- **Images**: Drag and drop images from any folder into edit views.
- **Page Analytics**: Displays analytics data about the site. This gadget is available by default on the Dashboard.
- **Page Info**: Displays information about the file currently being viewed or edited.
- **Quick Tasks**: Provides one-click shortcuts for frequently performed tasks in OU Campus.
- **Snippets**: Drag and drop any snippet into an edit view.
- **YouTube**: Drag and drop videos from YouTube into edit views. This gadget requires a YouTube account.

**Choosing Sidebar Gadgets**

The Choose Gadgets button can be used by each individual user to choose which gadgets to display on the Gadgets sidebar.
1. Click the **Choose Gadgets** icon to view the available gadgets.
   - A gadget with a green checkmark and green background indicates it is being shown on the sidebar.
   - A gadget without a checkmark indicates it is not being shown on the sidebar.

2. Click anywhere within the gadget box to either select or deselect the gadgets that are shown on the sidebar.